DESKTOP ENGRAVER

T95-30

Manufactured By Roland DG Corporation

User’s Manual

Thank you very much for purchasing this product.

3 . .
« To ensure correct and safe usage with a full understanding of this product's performance, please be sure to read through this
manual completely and store it in a safe location.

» Unauthorized copying or transferral, in whole or in part, of this manual is prohibited.
e The contents of this operation manual and the specifications of this product are subject to change without notice.

¢ The operation manual and the product have been prepared and tested as much as possible. If you find any misprint or error,
please inform us.

Roland DG Corp. assumes no responsibility for any direct or indirect loss or damage which may occur through use of this
product, regardless of any failure to perform on the part of this product.

Roland DG Corp. assumes no responsibility for any direct or indirect loss or damage which may occur with respect to any
article made using this product.




ROLAND DG CORPORATION
1-6-4 Shinmiyakoda, Hamamatsu-shi, Shizuoka-ken, JAPAN 431-2103
MODEL NAME : See the MODEL given on the rating plate.
RELEVANT DIRECTIVE : EC MACHINERY DIRECTIVE (98/37/EC)
EC LOW VOLTAGE DIRECTIVE (73/23/EEC)
EC ELECTROMAGNETIC COMPATIBILITY DIRECTIVE (89/336/EEC)

WARNING
This is a Class A product. In a domestic environment this product may cause radio interference in which
case the user may be required to take adequate measures.
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What's the TS-307?

This is an engraving machine that is operated by a computer. It can receive cutting data from your computer, and
engrave text and shapes.
The front cover is equipped with an interlock for outstanding safety.

You can use the included programs to create and output cutting data. For information on how to operate the programs,
refer to the electronic-format manuals or the online help.




To Ensure Safe Use

About AWARNING and AACAUTION Notices

AWARNING

Used for instructions intended to alert the user to the risk of death or severe
injury should the unit be used improperly.

ACAUTION

pets.

Used for instructions intended to alert the user to the risk of injury or material
damage should the unit be used improperly.

* Material damage refers to damage or other adverse effects caused with
respect to the home and all its furnishings, as well to domestic animals or

About the Symbols

£\

"danger of electrocution."

The /\ symbol alerts the user to important instructions or warnings. The specific meaning of
the symbol is determined by the design contained within the triangle. The symbol at left means

®

The © symbol alerts the user to items that must never be carried out (are forbidden). The
specific thing that must not be done is indicated by the design contained within the circle. The
symbol at left means the unit must never be disassembled.

<

The @ symbol alerts the user to things that must be carried out. The specific thing that must
be done is indicated by the design contained within the circle. The symbol at left means the
power-cord plug must be unplugged from the outlet.

AWARNING

®

Do not disassemble, repair, or modify.

Doing so may lead to fire or abnormal op-
eration resulting in injury.

Ground the unit with the ground wire.

Failure to do so may result in risk of electro-
cution in the event of a mechanical problem.

N

Do not use with any electrical power
supply that does not meet the ratings
displayed on the unit.

Use with any other power supply may lead
to fire or electrocution.

N

Do not use while in an abnormal state
(i.e., emitting smoke, burning odor,
unusual noise, or the like).

Doing so may result in fire or electrocution.
Immediately switch off the power, unplug the
power cord from the electrical outlet, and
contact your authorized Roland DG Corp.
dealer or service center.

Use only with the power cord included
with this product.

Use with other than the included power cord
may lead to fire or electrocution.

S

Do not connect the power cord with
other electrical loads on a single elec-
trical outlet.

Doing so may generate heat and cause fire.




To Ensure Safe Use

ACAUTION

N

Do not use with a damaged power
cord or plug, or with a loose electri-
cal outlet.

Doing so may lead to
fire, electrical shock,
or electrocution.

N

Do not damage or modify the electri-
cal power cord, subject it to exces-
sive bending, twisting, pulling, bind-
ing, or pinching, or place any object
or weight on it.

Doing so may dam-

age the electrical

power cord, leading g

to fire, electrical

shock, or electrocu-

tion.

When not in use for extended periods,
unplug the power-cord plug from the
electrical outlet.
Failure to do so may re- E: :

sult in danger of electri- 1 S
cal shock, electrocution,

or fire due to deterioration
of electrical insulation.

When unplugging the electrical power
cord from the power outlet, grasp the
plug, not the cord.
Unplugging by pulling
the cord may dam-
age it, leading to fire,
electrical shock, or
electrocution.

Do not attempt to unplug the power-
cord plug with wet hands.

Doing so may result
in electrical shock
or electrocution.

Do not allow liquids, metal objects or

flammables inside the machine.

Such materials

can cause fire. %

\/

Install on a stable surface.
Failure to do so may

result in the unit tipping /
over, leading to injury. i //,

ot s

Perform dry cutting with no cutting oil.

Such materials can cause fire. ﬁ@

When you're finished, wash your
hands to rinse away all cuttings.

Do not use any blower like airbrush
to remove cuiting dust.

Eailure to do so may harm your health due to
spread cutting dust in the air.




e

ACAUTION

Cutting dust which presents danger
of explosion clear away by using a
commercially available brush.
Attempting to use a
vacuum cleaner to
take up such cuttings //

may cause fire in the

vacuum cleaner. A

<

Unpacking, installation, and moving
are operations that must be carried out
by four or more persons.

Failure to do so may result in falling of the
unit, leading to injury.

Switch off the machine and unplug the
power cord from the electrical outlet
before performing cleaning or main-
tenance.

Failure to do so may result in injury or elec-
trical shock.

To Ensure Safe Use

O

Do not touch the tool immediately af-
ter cutting operating stops.

The tool may have become hot due to fric-
tion heat and may cause burns if touched.

O

Do not touch the spindle motor imme-
diately after a cutting operation has
ended.

Doing so may result in burns.

N

Do not operate if a front cover is
cracked or broken.

Failure to do so may result in injury. If the
front cover is cracked, contact a service agent
immediately for repairs.




To Ensure Safe Use

About the Labels Affixed to the Unit

These labels are affixed to the body of this product.
The following figure describes the location and content of these messages.

It is high temperature.

Use care to avoid being pinched.
Keep hands away during opera-

tion.

ACAUTION
romove cutting dust.

use a vacuum cloaner to
Do not use any blower ke airbrush. Otherwiss, dust
sproad in the air may harm your hoaith or damage this
machine.
APRECAUCION
Por favor, utilice un aspirador para limplar la viruta y el

polvo.
No utilice aire a presion para la impleza, podria averlar fa
maquina, y no seria conveniente para su salud respirar el
polvo.

APRUDENCE

Veuillez utiliser un aspirateur pour enlever Ia poussidre.
Jamals tlzer do projectairs & d'air. La poussidre

soutflée dans I'air peut causer des probldmes de

respiration et endommager votro machine.

AVORSICHT
St

ub mit einem

Niemals e nden. Der i
‘Staub ist gesundheitsschadlich und kann die Funktion
Ihers Gerits beeintréichtigen.
ACAUTELA

Usare un uplrmro per rimuovere poivere o trucioll da
lavorazione.

altrimenti la
noﬂlﬂ.polmbbﬂv.sunnodvlﬂhmm © dannoggiare
lamacchina.

AEr

DHBLROABRO Y —F — tlm,-(lﬁur'rzu
RERLTITHAIEBLENTTFE
wlnmuunullwIILnozu Im.u)u,
HRMORBEZVET.

S§§ - Do not touch immediately after a
cutting operation has ended.

Use caution when handling or
working with the blade. Careless
handling may result in injury.

WARNING: To reduce the risk of Injury, user
must read and understand user’s manual.

Model name
Rating plate
Use a rated power supply.

In addition to these symbols, the symbols shown below are also used.
@ Notice : Indicates information to prevent machine breakdown or malfunction and ensure correct use.

(%) poim

: Indicates a handy tip or advice regarding use.




This section describes what to do when you first open the packing car-
ton, including installing the machine and connecting the power cord.



1-1 Included ltems

The following items are packed together with the unit. Make sure they are all present and accounted for.

\§’

Power cord : 1 Collet : 1 (*1) Wrenches Hexagonal screw driver
(17 mm:1, 10 mm:1) (2 mm) :1

Hexagonal wrench CD-ROMs : 2 Manuals : 2
(2.5mm) : 1

*#1 This is for diameter 4.36 mm character cutters.
* This machine does not come with a cutter and cutter holder.

8 Chapter 1 - Getting Started




1-2 Parts Names

Spindle head

Vi Cutter holder

Collet

Operation Panel

Table

Front cover
This cover is equipped with an interlock. Opening
the front cover while engraving is in progress
causes the engraving to stop.

I Side

@ ® B Spindle controller connector
|
@

_

USB connector

r Power switch

This is the main power switch of the machine.
When the power is switched on, the POWER light
comes on.

Power-cord connector

Chapter 1 - Getting Started g




1-2 Parts Names

| Operation Panel

POWER light
This lights up when the power is
switched on.

@ POWER

ENGRAVING light

@ ENGRAVING

This lights up when the [STANDBY]
button is pressed while the power is
switched on.

@ SCANNING

SCANNING light (optional)
This lights up when the [STANDBY]
button is pressed while using the op-
tional scanning unit.

©

(b__._

@

VIEW light
This lights up when the machine is
paused. During lights up, the machine
doesn't operate.

Chapter 1 - Getting Started
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—— Emergency stop switch

This switch is used to stop the machine
in the event of an emergency.

STANDBY button

Pressing this button while the power is
switched on makes the machine starts
up, and perform initialization.

VIEW button
This pauses the machine.

TOOL-UP button/TOOL-DOWN button
These buttons move the spindle head up
and down. Pressing one of the buttons
once moves the spindle head about 0.05
millimeters.




1-3 Installation and Connection

Install on a stable surface.
Failure to do so may result in the unit tipping over, leading to injury.

Unpacking, installation, and moving are operations that must be carried out by four or more persons.
Failure to do so may result in falling of the unit, leading to injury.

Use this machine in an environment that meets the following conditions.

e Temperature of 5 to 40 °C (41 to 104 °F) and relative humidity of 35 to 80% (with no condensation).
* A level location with no wobble.

e Little dust.

» Little vibration.

¢ Good ventilation and heat dissipation.

* Low electrical noise. For example, avoid installing near an electric motor.

Also ensure that the following amount of space is available.

Installation space
700 (W) x 800 (D) x 600 (H) mm (27-5/8 (W) x 31-1/2 (D) x 23-5/8 (H) in.)

Chapter 1 - Getting Started 11




1-3 Installation and Connection

The retainers shown below is attached to this machine when it is shipped from the factory. When you have finished
installing the machine, detach the retainers.

Retainer

’f Remove the screw shown in the figure, then
detach these retainers.

After detaching these retainers, mount the
screw at its original location on the machine.

Retainer

12 Chapter 1 - Getting Started




1-3 Installation and Connection

Ground the unit with the ground wire.
Failure to do so may result in risk of electrocution in the event of a mechanical problem.

Use with other than the included power cord may lead to fire or electrocution.

Do not use with any electrical power supply that does not meet the ratings displayed on the unit.
Use with any other power supply may lead to fire or electrocution.

o Use only with the power cord included with this product.

Make sure the power to the machine is switched off before attempting to connect or disconnect the cables. Connect securely to
ensure that accidental disconnection does not occur during operation.

Connecting the Power Cord

© B
®
5]
Power outlet
= [ e e e o o 1
@ 10 \} > 'QB
Power connector 1 '4’
E l S
| asas
; \ \__—-7  Power cord
|
|

Netice

Do not connect the USB cable yet.
You connect the USB cable when you install and set up the software.

=5 See "1-5 Installing and Setting Up to the Software."”

Chapter 1 - Getting Started




1-4 System Requirements

Operating system Windows 98/Me/2000/XP
Computer Computer running Windows (Pentium processor or better recommended)
Drive CD-ROM drive
Monitor Windows-compatible monitor capable of displaying 256 colors or more
Memory (RAM) 32 MB or more recommended

Free hard-disk space 32 MB
required for installation

Interface USB port

Operating system | Windows 98/Me/2000/XP (Windows 95 and Windows NT4.0 are not supported.)

Computer 1) Computers preinstalled with Windows 98/Me/2000/XP at the time of purchase
(This includes such computers later upgraded to Windows Me/2000/XP.)
2) Computers on which USB operation is assured by the manufacturer of computers

e The ability to make a USB connection depends on the specifications of the computer. To determine whether the
computer you're using is capable of correct USB operation, check with the manufacturer of the computer.
* Use a shielded USB cable having a length of 3 meters or less. Do not use a USB hub or the like.

14 Chapter 1 - Gelting Started




Software Included w:th 3the Mach

1-5 Installing and Setting Up to the Software

MODELA Player

This program is for free cutting three-dimensional shapes. You can not perform designing
using this program alone. MODELA 3D Design and MODELA 3D Text are 1ncluded

Dr.Engrave

This program is for flat engraving of nameplates and the like. It can use any TrueType fonts
registered with Windows. It also comes with its own stroke fonts. You can even import images
and engrave items such as logos. There is even a feature that lets you import data from a list of
names and engrave nameplates one after another.

3D Engra\;e

This program is for designing and engraving reliefs (raised engravings). This lets you easily
add thlckness to text, shapes, and imported i images, and create three- d1mens1onal rehefs

Virtual MODELA

This program is for performing simulations before you actually carry out cutting using 3D
Engrave or MODELA Player. It lets you verify the finished results for shapes, the time re-
qulred for cuttlng, and other factors. This can help reduce loss in terms of material and time.

7 Windows driver

This is a Windows-based driver required for sending data from a computer to the machine. Be
sure to install it when you are using any of the programs just described.

Point

Information on how to use the included software is found in the electronic-format manual and online help for each program.

15" See "1-7 Viewing Electronic-format Manuals and Online Help."
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1-5 Installing and Setting Up to the Software

| Netice

Keep the printer and the computer unconnected until you carry out this installation operation. Failure to follow the

correct procedure may make installation impossible.

"

15 See "1-5 Installing and Setting Up to the Software -- What to Do If Installation Is Impossible.

Connecting a USB Cable
? Before you start installation and setup, make
sure the USB cable is not connected.

Log on to Windows as “Administrators” account.

Insert the Roland Software Package CD-ROM
into the CD-ROM drive.

The setup menu appears automatically.

1and chocse th2 rmade name

tep 2
& Click {lostalt;.

the description of & program,
igw the manuat.

raferances. Acr
fila:

4 Switch on the power switch, and press the
[STANDBY] button on the operation panel.

The machine starts up, and initialization is performed.

5 Connect the machine using a USB cable. Machine Computer

® b -

The [Found New Hardware Wizard] appears.

(5]
==

@

® « D =9

USB cable

16 Chapter 1 - Getting Started




1-5 Installing and Setting Up to the Software

s e s

Choose [Install the software automatically (Rec-
ommended)], then click [Next].

Installation of the USB driver starts automatically.

Welcome to the Found New
Hardware Wizard

a3 insted schwans o

sz or Hoppy disk. insert it now.

Wit docyou wart the wizard ic o ?

Ciick Meat o cortrue.

When the screen appears, click [Continue Any-

way].

Tha seftwanz you ane ingtaliig for s hardwans:

Predars

hes nn pagsed Windows L
2ith Yrdows 2P {Tehme

Continuing your & ion of thi impaic
or the comect ion of your system
either immediately or in the fulure. Microsoll shrongly
recommends that you stop this insizliation row and
contact the hardware wendor for seftware that has
paszed Windows Loge testing.

( ot A ST instelation &

Click [Finish].

This completes the installation.

Completing the Found New
Hardware Wizard

The wizard has finished inztaiing the scitwane for:

Tlick Finish to cloze the wirand.

Chapter 1 - Getting Started 17



1-5 Installing and Setting Up to the Software

18

1

5

Installing the Software

Appear the setup menu of the Roland Software
Package.

Select [TS-30].

Clear the [Windows Driver] check box, then click
[Install].

If you do not want to install a particular program, than
before you click [Install], clear the corresponding check
box.

The setup program starts. Follow the messages
to carry out setup and finish setting up the pro-
gram.

When the setup for one program finishes, the setup for
the next program starts. In the interval unit the next setup
starts, a dialog box showing the progress of processing is
displayed.

When all installation finishes, the screen shown
at right appears. Click [Close].

After returning to the menu screen for installa-

6 Remove the CD-ROM from the CD-ROM drive.

Chapter 1 - Getting Started

Virtual MODELA

‘BrEngrave

3B Engrave . | :

indows Briver

Go to Reland DG Corpos

here are manusis in POF format for
the programs that the (28 button
refere okat Reader is reguired

the drap-down arrow for fCtick 4
cheose the madst name 1
o view POF files )

Welcome to the MODELA Setup program. This
program willinstall MODELA on your computer.

Itis strongly recommended that you exit all Windows programs
before running this Setup program.

Click Cancel to quit Setup and then close any programs you
have running. Click Nest to continue with the Setup program.

WARNING: This program is protected by coppright law and
international treaties.

Unauthorized reproduction or distibut

of this program, or any
portion of it, may result in severs civil and criminal penalties, and
will be prosecuted ta the maximum extent possible under law.




1-5 Installing and Setting Up to the Software

Notice

Keep the printer and the computer unconnected until you carry out this installation operation. Failure to follow the
correct procedure may make installation impossible.

1 See "1-5 Installing and Setting Up to the Software -- What to Do If Installation Is Impossible.”

’? Before you start installation and setup, make
sure the USB cable is not connected.

Log on to Windows. If you are installing under
Windows 2000, log on as “Administrators” ac-
count.

Insert the Roland Software Package CD-ROM
into the CD-ROM drive.

The setup menu appears automatically.

Choose [TS-30], then click [Install].

If there are programs you don't want to install, then clear o Vi {701 Clckine droo-down armow for (Click

here ] and choose the modei name.

their check boxes before you click [Install]. o o Step 2
: Click [install]

& Toview the description of a program,
click the [i] button. To view the manual,
click the [?] buiton. §
(There are manuals in PDF format for the &:
& programs thatthe (7] button references
Acrohat Reader is required to view PDF
files)

- @ Windows Briver

orperation Homepage

The setup program starts. Follow the messages
to carry out setup and finish setting up the pro-
gram.

When the setup for one program finishes, the setup for
the next program starts. In the interval until the next setup
starts, a dialog box showing the progress of processing is
displayed.

6 Next, install the driver.

Select [Install]. From [Port] box, select [USB],
then click [Start].

Installation of the driver starts.

Chapter 1 - Getting Started 19




1-5 Installing and Setting Up to the Software

7 When all installation finishes, the screen shown
at right appears. Click [Close].

8 When the setup menu for installation reappears,

Install

g Remove the CD-ROM from the CD-ROM drive.

-g@ Switch on the power switch, and press the
[STANDBY] button on the operation panel.

The machine starts up, and initialization is performed.

? ? Connect the machine to your computer using a Mackite ot
USB cable. =
The driver is automatically registered in your computer. o
Dt [ JE————y

USB cable

20 Chapier 1 - Getting Siaried




1-5 Installing and Setting Up to the Software

If installation quits partway through, or if the wizard does not appear when you make the connection with a USB cable,

take action as follows.

| Windows XP/2000

«? If the [Found New Hardware Wizard] appears,
click [Finish] to close it.

For Windows XP

Click the [Start] menu, then right-click [My Com-
puter]. Click [Properties].

For Windows 2000
Right-click [My Computer] on the desktop. Click
[Properties].

3 Click the [Hardware] tab, then click [Device
Manager].
The [Device Manager] appears.

@ At the [View] menu, click [Show hidden devices].

5 In the list, find [Printers] or [Other device], then
double-click it.

When [Roland TS-30] or [Unknown device] ap-
pears below the item you selected, click it to
choose it.

ﬁ Go to the [Action] menu, and click [Uninstall].

The screen shown at right appears.
Click [OK].

Adomay

ioe Manages fzte & the Fardware devicez heialled
o0 your coapder. Use the Devics Mansgerts changs the
oropedies of ary device.

{ Diwer Sigring

‘i

Hardware profiies provide 3 way for v e 76t up and share
differert hadware corfigurstions.

sk drives
Dispday adapizrs
ACOROM dhives

OF ATA/RTAPT controlers
eybosrds

Ve and oier pointing devices
i vonitors

fletwork adapiers
Nan-Plug and Riay Drivars

Uriversa] Senzl Bus controllzrs

Feland T30

Waming: Yo 202 zbved brorinstel teis dzdce from pror gpem.

& =0
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1-5 Installing and Setting Up to the Software

1

6
7

22

Close the [Device Manager] and click [OK].
Detach the USB cable connected to the printer.
Restart Windows.

Follow the procedure in "1-5 Installing and Set-
ting Up to the Software -- Windows XP or Win-
dows 98/Me/2000" to redo installation from the
beginning.

Windows 98/Me

Unplug the USB cables from your computer.

Appear the setup menu of the Roland Software
Package.

Select only the [Windows Driver] check box, and
clear all other check boxes.

Click [Install].

The next screen appears.

Select [Uninstall], then click [Start].

When driver is deleted, the next screen appears.

Click [Yes] to restart the computer.

Follow the procedure in "1-5 Installing and Set-
ting Up to the Software -- Windows 98/Me/2000"
to redo installation from the beginning.
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1-6 Uninstalling the Driver

When uninstalling the driver, perform following operation.

1 Before you start uninstallation of the driver,
unplug the USB cables from your computer.

2 Log on to Windows as “Administrators” account.
From the [Start] menu, click [Control Panel].

Click [Printers and Other Hardware], then click
[Printers and Faxes]. :

Click the [Roland TS-30] icon. B
From the [File] menu, choose [Delete]. e LD sean 7 rokns | [

Set as Default Printer
Printing Preferences...

Pause Printing

Sharing...
Use Printer Offine

Add Printer
Server Properties
SetUp Faxing

h
Properties

Close

When the screen prompting you to confirm de-
leting appears, click [Yes].

2 2) tre yousure you went o dektethepriner Roland 75307

From [File] menu, click [Server Properties].

The next screen appears. I add prinier
Server Properties

Folders v

Setup oAy

Click the [Drivers] tab. Choose [Roland TS-30]
from the list, then click [Removel].

Installed piner divers:
Name i Envionmert | Version :
Roland T5:30 intel Windows NT 48 or 2005

7] {(Cgemove )] [ Regioce Propertics
K Coomedl )| i
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1-6 Uninstalling the Driver

g When the screen prompting you to confirm de-
leting appears, click [Yes].

Insert the Roland Software Package CD-ROM
into the CD-ROM drive.

The setup menu appears automatically.

f@ At the setup menu, select only the [Windows
Driver] check box, and clear all other check
boxes.

74? Click [Install].

The next screen appears.

f‘? Select [Uninstall], then click [Start].

When driver is deleted, the next screen appears.

1 3 Click [Yes] to restart the computer.
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1-6 Uninstalling the Driver

When uninstalling the driver, perform following operation.

-? Before you start uninstallation of the driver,
unplug the USB cables from your computer.

Log on to Windows. If you are installing under
Windows 2000, log on as “Administrators” ac-
count.

Insert the R0|and SOftware PaCkage CD-ROM : - Click the drop-down arrow for [Click
IntO the CD"ROM dl’lve . - here) and choose the model name.

3 2 Step 2
The setup menu appears automatically. S _ Citck instat)
: To view the description of a program,
3 : cl!ckths[gbul:tu:n To view the manual,
At the setup menu, select only the [Windows P Thare ate manuals in POF frmatar he. 1
& o - programs that the [?] button references.
Driver] check box, and clear all other check 1 S e s a0

boxes.

Homepage

Click [Install].

The next screen appears.

Select [Uninstall], then click [Start].

When driver is deleted, the next screen appears.

Model
{Roland TS-30 i

Click [Yes] to restart the computer.
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1-7 Viewing Electronic-format Manuals and Online Help

For information on how to use the included programs and drivers, refer to the manuals in electronic format or the online

help.

Viewing Manuals in Electror

? insert the Roland Software Package CD-ROM
into the CD-ROM drive.

The setup menu appears automatically.

Choose [TS-30].

3 Click the [?] button. Acrobat Reader starts and
the user’s manual is displayed.

There are three ways to view online help.
Clicking the Help Menu in the Program

-i From the [Help] menu, click [Contents].

2 Clicking on text that is green and underlined
(by a solid or dotted line) displays an explana-
tion.

Clicking the [?] Button in the Window

Clicking [?] in the upper-right corner of the window makes
the mouse pointer change to a question mark ( [%? ). You
can then move the pointer over any item you wish to
learn more about, then click on the item to display an ex-
planation of it.

Clicking the [Help] Button in the Window

Clicking [Help] lets you view help for the window or soft-
ware.
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: l Install

= Step 1

4 Virtoal MODELA Click the drop-down amow for [Click
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2

This chapter describes the operation of the machine up to the point of
starting engraving, including how to switch the machine on and off and
how to install a cutting tool.
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To starting the machine, follow the steps described below.

? Make sure the front cover is closed.

Switch on the power switch.
The POWER light comes on.

»‘ﬂ
3 Press the [STANDBY] button. ‘ Io

The ENGRAVING light comes on. The machine starts
up, and initialization is performed.

After initialization ends, the VIEW light comes on and
the machine is paused.

4 Press the [VIEW] button.

The view state is canceled, and the machine finishes
preparations for receiving cutting data.

Switching Off the Power

Switch off the power switch.
The POWER light goes dark and the power to the machine is switched off.
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-2 Emergency Stop to Ensure Safety

This switch stops the machine in an emergency in order to
avoid danger. Pressing the emergency stop switch immedi-
ately halts operation and aborts engraving.

Point

Releasing the Emergency Stop Switch

Turning the switch in the direction of the arrow releases the emergency stop switch.

Opening the front cover during operation interrupts engraving, and the ENGRAVING and VIEW lights flash.

To recover from this, close the front cover, and press the [STANDBY] button to clear the error.

It is possible to open the front cover while the machine is paused. To pause the machine, refer to “ 2-5 Stopping and
Pausing Engraving.” When you open the front cover, the VIEW light flashes every two seconds. Closing the front cover

stops the flashing.
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2-3 Installing the Cutter

cuo

Install the cutter, adjusting the blade length to match the thickness of the material. When you change the other one,

readjust the blade length of the cutter.
Front cover

? Open the front cover.

NS

2 While using the wrench (17 mm) to keep the
spindle immobile, tighten a cutter holder se-
curely.

Point

A cutter holder is reverse-threaded (that is, you turn
it counterclockwise to tighten it). Be careful to turn
it in the correct direction.

P

/

Wrench (17 mm)

Insert the collet from below. %
3 =) [P

4 Use the wrenches (17 mm and 10 mm) to
tighten the collet.

Wrench (17 mm) Wrench (10 mm)
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2-3 Installing the Cutter

5 Switch on the power switch, and press the
[STANDBY] button on the operation panel.

Initialization is performed, and the VIEW light comes
on.

6 Press the [VIEW] button.

The view state is canceled.

? Press the [TOOL-DOWN] button to lower the o i
spindle head and bring the tip of the collet close

to the surface of the material. °
Q
The height of the spindle head at this time is set as the ﬂ D

depth-direction base point.

Insert a cutter into the spindle, making the tip
of the cutter touch the surface of the material.

) ) Tool securing
Use the hexagonal screw driver to tighten the LJ screw

Screw.

Point \@_)_QH D Hexagonal
%] :
After you have set the depth-direction base point, SOro CIver

do not press the [TOOL-UP] or [TOOL-DOWN]
buttons. Doing so will change the location of the base
point.

1 @ Close the front cover.
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2-4 Starting Engraving

Perform dry cutting with no cutting oil.
Such materials can cause fire.

® Do not operate if a front cover is cracked or broken.
Failure to do so may result in injury. If the front cover is cracked, contact a service agent immediately for repairs.

32

Engraving is started after receiving cutting data from your computer.
Before performing engraving, make sure the following two points have been carried out.

e The front cover is closed.
* The View light goes out.
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2-5 Stopping and Pausing Engraving

To Pause Engraving

Press the [VIEW] button. Pressing the [VIEW] button moves the spindle head to the left edge and the table to the front
of the machine.

It is possible to open the front cover while the machine is paused. Before you open the front cover, make sure that
operation has stopped completely.

To Resume Engraving
Make sure the front cover is closed, then press the [VIEW] button again. |

? Press the [VIEW] button to pause operation.

Stop sending data from your computer.
For Windows XP

From the [Start] menu, click [Settings], then click
[Printers]. Click [Printers and Other Hardware],
then click [Printers and Faxes].

For Windows 98/Me/2000

From the [Start] menu, click [Settings], then click
[Printers].

Double-click the [TS-30] icon.

4 For Windows XP/2000 Roland T5-30

At the [Printer] menu, choose [Cancel All Docu-
ments]. |

For Windows 98/Me

At the [Printer] menu, choose [Purge Print
Documents].

5 Delete the cutting data remaining in the ma-
chine.
Press the [TOOL-UP] and [TOOL-DOWN] but-
tons at the same time.

The VIEW light flashes. When deletion of the data ends,
the VIEW light stops flashing.
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3-1 Maintenance

Do not use any blower like airbrush to remove cutting dust. Failure to do so may harm your health due to
spread cutting dust in the air.

Attempting to use a vacuum cleaner to take up such cuttings may cause fire in the vacuum cleaner.

Switch off the machine and unplug the power cord from the electrical outlet before performing cleaning

o Cutting dust which presents danger of explosion clear away by using a commercially available brush.
0 or maintenance. Failure to do so may result in injury or electrical shock.

36

(D) Notice

Do not use solvents such as thinner, benzine, or alcohol to clean.

e

Carefully clean away cutting waste. In addition to the table, also clean the spindle head.

Cleaning the Main Unit

When the main unit becomes dirty, use a dry cloth to wipe it.

Cleaning the Table and Around the Spindie Head

After cutting has finished, turn off the power to the main unit.
Use a vacuum cleaner or brush to clean the buildup of cuttings around the spindle head.
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3-2 What to Do If

If the lights on the operation panel are flashing as shown below, then an error has occurred on the machine. To correct
the error, follow the steps described below.

The ENGRAVING and SCANNING lights flash every 0.2 second.

An error occurred during initialization of the machine.

Switch the power off, then back on.

If the error is not cleared when you switch the power on again, the machine may be malfunctioning. Contact your
authorized Roland DG Corp. dealer or service center.

The ENGRAVING and VIEW lights flash every second.

The front cover was opened while an engraving operation was in progress.
Close the front cover and press the [STANDBY] button to clear the error.

The ENGRAVING light flashes every 0.2 second.

The spindle motor doesn't operate correctly.

Switch the power off, then back on.

If the error is not cleared when you switch the power on again, the machine may be malfunctioning. Contact your
authorized Roland DG Corp. dealer or service center.
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3-3 Specifications

TS-30
Table size 305 (W) x 305 (D) mm (12 (W) x 12 (D) in.)
Axis travels 305 (X) x 305 (Y) x 105 (Z) mm (12 (X) x 12 (Y) x 4-1/8 (Z) in.)

Loadable workpiece thickness

Maximum 125 mm (4-15/16 in.)

XYZ-axis motor

Stepping motor

Feed rate

XY-axis: 0.1 to 30 mm/s (0.0039 to 1.1 in./s)
Z-axis: 0.1 to 15 mm/s (0.0039 to 0.59 in./s)

Software resolution

0.01 mm/step (0.00039 in./step)

Mechanical resolution

0.002 mm/step (0.00008 in./step)

Spindle motor

DC brushless motor, Maximum 72 W

Spindle speed 3,000 to 10,000 rpm
Tool chuck Cutter holder (4.36 mm) and collet
Interface USB connector, and Spindle controller connector

Power supply | Voltage and frequency

AC100-240V =10 %, 50/60 Hz

Required power capacity

1.5:A

Power consumption

Approx. 150 W

Acoustic noise level

No-load operation : 55 dB (A) or less standby : 40 dB (A) or less (According to ISO 7779)

Dimensions

669 (W) x 760 (D) x 554 (H) mm (26-3/8 (W) x 29-15/16 (D) x 21-13/16 (H) in.)

Weight

62 kg (137 1b.)

Packed dimensions

785 (W) x 885 (D) x 735 (H) mm (31 (W) x 35 (D) x 29 (H) in.)

Packed weight

69 kg (153 1b.)

Operating environment

Temperature: 5 to 40°C (41 to 104°F) humidity: 35 to 80 % (no condensation)

Accessories

Power cord, collet, wrenches (17 mm, 10 mm), hexagonal screw driver, hexagonal wrench, CD-ROMs,
manuals
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3-4 Specifications

Pl

R ]

+24V ‘ - Compatible plug
T 100Q / 2W
W—1—O—O—C
Terminals '——14mm——
If (max) = 1A e i
3_ j=]
= e SN

olefo

SPINDLEON > Ny Ic (max) = 150mA

Use only a triple-contact plug of
the size described above.

() Notice

Do not use terminal ®. Use only terminals
® and @.

/77

This circuit is activated when the spindle motor is in operation.

Netice

» Use within the rated range shown above.
* Do not apply voltage greater than 24 V to the terminal.
¢ Do not short the terminal to ground.

R R

JUOS—

No responsible is assumed for effects to which any equipment connected to this external output connector is subjected.
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